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Disclaimer of liability

The contents of this documentation have been carefully checked for consistency with the hardware and
software systems described. Nevertheless, it is impossible to completely rule out inconsistencies, so that we
decline to offer any guarantee of total conformity.

We reserve the right to make technical modifications of the systems.

Copyright

© 2024 imc Test & Measurement GmbH, Germany

This documentation is the intellectual property of imc Test & Measurement GmbH. imc Test & Measurement
GmbH reserves all rights to this documentation. The applicable provisions are stipulated in the "imc Software
License Agreement".
The software described in this document may only be used in accordance with the provisions of the "imc
Software License Agreement".

Open Source Software Licenses

Some components of imc products use software which is licensed under the GNU General Public License (GPL).
Details are available in the About dialog.

If you wish to receive a copy of the GPL sources used, please contact our tech support.
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Notes regarding this document
This document is an excerpt from the manual of imc FAMOS. The manual for imc FAMOS is available both as an
chm and in PDF format. Click on the symbol  to open the help.

The program "imc Help and Documentation" (in the Start menu or via the menu ribbon "Help" > "Additional
Documents") provides you with access to the PDF-file and other documents.

What is the best way to read the imc FAMOS documents?

If you have already worked with an older imc FAMOS version, we recommend taking a look at the topic "Update-
Info" (What's new...). Here you can get a quick overview of changes and innovations implemented in the current
version.

Getting Started

Before installing the software, start by reading the document "Getting Started". This contains important tips for
achieving problem-free installation, as well as for operation.

All information presented in the document "Getting Started" is also presented in the imc FAMOS manual.

Manual - complete documentation

The manual serves as reference material. However, it is still recommended that you observe the entire
instructions in order to be able to use certain functions which are more interesting than obvious.

ReadMe

This presents info on changes and extensions in imc FAMOS which were implemented after this manual went to
print.

Tutorials

Following successful installation, we recommend working through the chapter "Tutorial " in order to get
quickly acquainted with the workings of imc FAMOS. It familiarizes you with the imc FAMOS operating
philosophy and basic operations in a convenient manner.

Training programs for introduction to the systems, and advanced workshops

We recommend that before you begin working with imc FAMOS you participate in an extensive training session.
Such training will enable you to get started working efficiently much faster. Additionally, you will obtain valuable
tips and information on how to use the software more effectively. More information is available on our
homepage under "Service & Training" > "imc ACADEMY".

Special notes

Warning

Warnings contain information that must be
observed to protect the user from harm or to
prevent damage to property.

 

Note

Notes denote useful additional information on a
particular topic.

Reference

A reference in this document is a reference in
the text to another text passage.
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1  General introduction

1.1  Before you start

Dear user.

1. The software you have obtained, as well as the associated manual are directed toward competent and
instructed users. If you notice any discrepancies, we request that you contact our tech support .

2. Updates during software development can cause portions of the manual to become outdated. If you
notice any discrepancies, we request that you contact our tech support.

3. Please contact our tech support if you find descriptions in the manual which you believe could be
misunderstood and thereby lead to personal injury.

4. Read the enclosed license agreement . By using the software, you agree to the terms and conditions of
the license agreement.

Note Notes on the descriptions and the screenshots

· The help may also contain parts shared imc software components. These parts may differ from the rest
of the help in terms of style and structure. All help files are equipped with a full text search functionality
and have an index.

· The screen shots appearing in this documentation were created with a variety of Windows versions and
their appearance may thus differ from that of your installed program.

1.2  Tech support
If you have problems or questions, please contact our tech support:

Phone: (Germany): +49 30 467090-26

E-Mail: hotline@imc-tm.de

Internet: https://www.imc-tm.com/service-training/

Tip for ensuring quick processing of your questions:

If you contact us you would help us, if you know the serial number of your devices and the version info of the
software. This documentation should also be on hand.

· The device's serial number appears on the nameplate.

· The program version designation is available in the About-Dialog.

Product Improvement and change requests

Please help us to improve our documentation and products:

· Have you found any errors in the software, or would you suggest any changes?

· Would any change to the mechanical structure improve the operation of the device?

· Are there any terms or explanations in the manual or the technical data which are confusing?

· What amendments or enhancements would you suggest?

Our tech support  will be happy to receive your feedback.

5

7

5

mailto:hotline@imc-tm.de
https://www.imc-tm.com/service-training/
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1.3  Service and maintenance
Our service team is at your disposal for service and maintenance inquiries:

E-Mail: service@imc-tm.de

Internet: https://www.imc-tm.com/service

Service and maintenance activities include, for example calibration and adjustment, service check, repairs.

1.4  Legal notices

Quality Management

imc Test & Measurement GmbH holds DIN EN ISO 9001 certification since May
1995 and DIN EN ISO 14001 certification since November 2023. You can download
the CE Certification, current certificates and information about the imc quality
system on our website:
https://www.imc-tm.com/quality-assurance/ and in the download area of imc
FAMOS.

imc Warranty

Subject to the general terms and conditions of imc Test & Measurement GmbH.

Liability restrictions

All specifications and notes in this document are subject to applicable standards and regulations, and reflect the
state of the art well as accumulated years of knowledge and experience. The contents of this document have
been carefully checked for consistency with the hardware and the software systems described. Nevertheless, it
is impossible to completely rule out inconsistencies, so that we decline to offer any guarantee  of total
conformity. We reserve the right to make technical modifications of the systems.

The manufacturer declines any liability for damage arising from:

· failure to comply with the provided documentation,

· inappropriate use of the equipment.

mailto:service@imc-tm.de
https://www.imc-tm.com/service
https://www.imc-tm.com/quality-assurance/
https://www.imc-tm.com/download-center/product-downloads/imc-famos/software/
https://www.imc-tm.com/download-center/product-downloads/imc-famos/software/
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1.5  imc Software License Agreement
imc Test & Measurement GmbH
Voltastr. 5
13355 Berlin, Germany 
Trade register: Berlin-Charlottenburg HRB 28778
Managing directors: Michael John Flaherty, Frank Mayer

imc Test & Measurement GmbH
Terms and Conditions

Governing the Use of imc Test & Measurement GmbH Software
As of: January 18, 2024

§ 1 Objects of the Agreement

(1) In addition to the "General Terms and Conditions Governing imc Test & Measurement GmbH Deliveries and Services to
Customers", these terms and conditions apply to all contracts concluded with  imc Test & Measurement GmbH
(hereinafter referred to as "imc") which involve the transfer of rights of use to any software developed by imc (standard
software, software created or adjusted specifically for the Customer, which is recorded on the machine-decodable data
carriers such as data files, databases and database material, updates, upgrades, releases, etc., including corresponding
documentation, information and materials, hereinafter referred to as "Software").

(2) The Software is provided to the Customer as an executable object program on machine-decodable data carriers specified
in the "Objects of the Agreement". The Software's product documentation is also supplied to the Customer either in print
or on a machine-decodable data carrier. Unless otherwise expressly agreed in writing, the Customer is not issued the
source code of the Software.

§ 2 Rights of Use, Scope

With regard to any transfer of rights of use to Software created by imc, the following provisions apply:

(1) Basic provisions

 a) The Customer is granted a non-exclusive and – subject to the terms and conditions governing the use of Software by
third parties, resale and leasing – non-transferrable right of use to the Software for its own purposes. "Use" signifies
running the programs and editing the data records.

 b) Until each due fee is paid in full, the Customer is entitled to use the Software solely on a revocable basis. If the
Customer is in default with regard to the payment of fees, imc is entitled to revoke the use of the respective services
for the duration of the default. The Customer is granted the permanent right to use copyright protected services, in
particular the Software, only upon full payment of the agreed fee.

 c) The Customer agrees to undertake appropriate precautionary measures to prevent unauthorized access by third
parties to the Software. The original data carriers and the data carries used to make copies as per the agreement, as
well as the documentation, are to be stored in a secure location. Employees are to be notified that the production of
copies beyond the scope of the agreement is not permitted.

 d) If the right of use is revoked or expires due to another reason, the Customer is obligated to return to imc the
Software, the copies made by the Customer and the documentation. Provided that a physical return of the Software
and the copies is not possible due to technical reasons, the Customer is obligated to delete such and confirm deletion
to imc in writing.

(2) Reproduction

 a) The Customer is entitled to make copies of the Software only if copies are necessary to use the Software in
accordance with the contract. The following are considered cases in which reproduction is necessary: installation of
the Software from the original data carrier onto the hard disk drive of the hardware used, as well as loading the
Software into the computer memory. 

 b) The Customer is entitled to create a backup copy if such is necessary to safeguard future use. Copies may only be
made for other purposes after prior written consent has been issued by imc. 

 c) The Customer is not allowed to make any reproductions other than those expressly permitted under the provisions of
this agreement.
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(3) Use of the Software by Third Parties, Resale and Leasing

 a) The Software may be used for the purposes stipulated in this contract, in particular for the Customer's business
operations. Access to the Software may also be provided to parties which rely on using the Software as instructed by
the Customer. In particular, the Customer is entitled to operate the Software or allow the Software to be operated on
data processing devices, which are located on the premises of and are directly owned by a third party company
(outsourcing). The prohibition against multiple use remains unaffected. 

 b) The Customer may permanently sell or give the Software to third parties provided that the Customer is granted
permanent use of the Software. In the context of its period of use, the Customer may temporarily transfer the
Software to third parties for a fee or free of charge. The prohibition against multiple use remains unaffected. The
Customer is expressly notified that transfer to third parties is not permitted and use by third parties is technically not
possible if an individual license must be acquired or an individual activation is required for third party usage, such as in
the case of runtime licenses.

 c) With regard to the valid use of Software by a third party, the Customer is obliged to ensure that the third party
acknowledges the provisions of this agreement governing the rights of use as binding for such third party. The
Customer may not transfer Software and documentation to third parties if there are grounds to suspect that the third
party may infringe upon the provisions of this agreement governing the rights of use, in particular with regard to the
unauthorized production of copies. 

 d) Subject to the provisions stipulated in § 4 Paragraphs 1 and 2 or a deviating express agreement in writing, the
Customer may not use the Software while the Software is being used by a third party (prohibition against multiple
use); in the event that the Software is transferred to the third party, the customer is obliged to surrender to imc all
Software copies including, if applicable, all existing backup copies, or to destroy copies not surrendered.

(4) Decompilation

The reverse translation of the provided program code into other code forms (decompilation), disassembling and other
forms of reverse engineering of the various production phases of the Software is not permitted. If interface information is
required to achieve the interoperability of a separately created computer program, such may be requested from imc, or a
third party to be named by imc, for a minor fee. Section 69 e of the German Copyright Act ("UrhG") remains unaffected
by this provision.

(5) Changes by imc

If imc conducts adjustments, changes or enhances the Software on behalf and on account of the Customer, the Customer
thus acquires the corresponding rights of use to the changes or enhancements of the Software to which he is entitled
according to the stipulations of this agreement.

(6) Exceptional Usage Requests by the Customer

If the Customer requests to use the Software according to terms which deviate from the requirements stipulated in
Paragraphs 2 through 5, this exceptional use of the Software must be agreed in writing by imc. In such an instance, the
Customer agrees to provide imc with information about the desired scope of use, the pertinent field of application, etc. If
imc subsequently grants a license covering the Customer's special intended use, the parties agree that a new license fee is
owed by the Customer, which is independent of payments made by the Customer for the previously existing license.

§ 3 Copyright, Protection of the Software

(1) The intellectual property, in particular the copyright as well as all industrial property rights and trade secrets, are retained
by imc and are not transferred to the Customer. The Customer's ownership of the machine-decodable data carries and
data processing units remains unaffected.

(2) Copyright notices, serial numbers as well as designations and reservations of rights which serve as program identification
or a protective right may not be removed or changed. The Customer is obliged to transfer the existing protective right
notices to all copies. In particular, backup copies of the Software must be expressly designated as such.

§ 4 License Types, Multiple Use

(1) In the case of a Single-User License, the Software may be activated and run on only one data processing unit. "Activation"
refers to the process of transferring the license to the data processing unit.

If the technical specifications for the Software permit a second activation, then the Customer may additionally activate
the Software on a second data processing unit. However, the Software may only run on one data processing unit at any
one time, not on both simultaneously.
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(2) With a Network License, the Software may be run on as many data processing units as the amount of licenses obtained.
In this case a central data processing unit acts as the license server for which the activation process is performed.

If the technical specifications for the Software permit a second activation, then the Customer may additionally activate
and run the Software on as many data processing units as the amount of licenses obtained. However, these additional
data processing units must be used by the same users who operate the Software via the license server.

(3) Subject to the provisions in Paragraphs 1 and 2 or a deviating express agreement in writing regarding network use,
multiple use of the Software is not permitted.

(4) If the data processing unit is changed, the Customer is obliged to delete the Software from the hard disk drive of the
previously used hardware.

§ 5 Software-Subscription

If the Software used is a software-subscription, the following additional restrictions apply:

(1) The right of use is valid for a limited time period. The start and end of the time period are specified. After the end of the
time period, the right of use is expired.

(2) If the Customer wishes to continue using the Software after elapse of the specified time period, the subscription must be
renewed.

§ 6 Trial Version

If the Software used is a free trial version, then the following additional limitations apply:

(1)  The trial version only entitles the user to test the Software. In particular, commercially productive utilization is not
permitted.

(2)  The rights of use granted expire after the elapse of a period stated in the product description.

§ 7 License Key

(1) Upon delivery of the Software the Customer receives a License Key. Using this License Key, the Customer is able to
activate the Software purchased. By means of this License Key the Customer can also view his license status and order
updates and upgrades.

(2) The License Key is to be protected against access by third parties in order to prevent misuse. If, however, a third party
gains unlawful access to the Key, the Customer is obliged to notify imc immediately via telephone, as well as in writing, so
that the previous License Key may be suspended and a new one issued.

§ 8 Conclusion

(1) The law of the Federal Republic of Germany shall apply under exclusion of private international law. The provisions of the
UN Convention on Contracts for the International Sale of Goods (CISG) do not apply.

(2) The place of performance for all obligations arising from this agreement is imc's registered seat. Insofar as the Customer
is a merchant as defined by the German Commercial Code (HGB), a legal entity under public law, or a special asset under
public law, the exclusive place of jurisdiction for all disputes directly or indirectly arising from the contractual relationship
is agreed as imc's registered seat. The same applies to persons who have no general place of jurisdiction in Germany, as
well as to persons who have moved their place of residence or usual whereabouts abroad since conclusion of the
contract, or whose place of residence or usual whereabouts is unknown at the time the action is filed. In addition, imc is
entitled to file suit at the statutory venue.

(3) Oral side-agreements are not valid. Deviating or supplementary conditions as well as modifications of this contract,
including this written requirement clause, are only valid if agreed in writing and expressly marked as a modification or
supplement.

(4) If certain provisions of this contract are inoperative or unfeasible, this does not prejudice other provisions of the contract.
The contracting parties agree to contractually substitute an operable provision which approximates the commercial
intention of the contract as closely as possible for any inoperable one.
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2  Foreword
imc FAMOS (Fast Analysis and Monitoring of Signals) is a software program for analysis and evaluation of
measurement results. With an extensive range of functions conceived especially for the needs of measurement
and control applications, imc FAMOS eliminates much of your routine work in a comfortable fashion.

With imc FAMOS , you can process large data sets quickly and efficiently and create computational procedures
using standard mathematical notation. No specialized programming expertise is required! Furthermore,
imc FAMOS offers powerful means for displaying your data in charts or tables and for printing these in
individually designed reports.

imc FAMOS processes measured data produced by imc devices (e.g. imc CRONOS, imc C-SERIES). The scope of
functions also includes a large number of import- and export filters for common file formats (e.g. the standard
formats of different manufacturers of measurement devices). 

The task of importing data into an analysis program which are not expressed in a directly supported file format is
often the first and most difficult problem involved with analyzing measured data. Toward this end, imc FAMOS
offers support in a variety of ways: for simple ASCII formats, for example, a flexible and easily configured
Assistant is provided. For more complex formats, the imc File Assistant can be used, by which means the user
can personally create import filter, even without possessing any programming skills. 

imc FAMOS is principally conceived for use in offline evaluation of data and cannot be used to control
measurement instruments

imc FAMOS can be expanded with add-on modules and function libraries. Expansions are available which, for
example, make it possible to design digital filters or to classify measurement data. Furthermore you can add
your own self-written function libraries to imc FAMOS.
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3  Setting up - Software

3.1  System requirements

Supported operating systems  

Windows 10*/11* (64 bit)  

Windows 2016/2019/2022 Server (64 bit)  

*released in conformance with the version of Windows 10 /
Windows 11 applicable at build date of imc software

For the purpose of assigning imc FAMOS network licenses by means
of the License Manager, support of Windows 2003 Server
continues.

 

Minimum requirements for the PC  

Processor with 1 GHz  

2 GB RAM  

1 GB free hard disk drive (NTFS format)  

Languages:

German, English for programming. GUI also supports Japanese , French, Chinese, Korean partially.

Microsoft ® Excel:

In order to be able to import or export files in Microsoft ® Excel format (*.xls,*.xlsx), Excel must be installed
on the same computer. The following versions are supported:

· Excel 2010, 2013, 2016, 2019, 2021 (except "Starter Edition"), Microsoft 365*
*released in conformance with the version of Microsoft 365 applicable at build date of imc software

Other operating system components

The following components are installed with the imc FAMOS setup if they are not already present:

Component Version Folder in "OSUpdate" directory

Microsoft .NET Framework 4.8.3761.0

4.8.4115.0

ndp48-x86-x64-allos-deu.exe

ndp48-x86-x64-allos-enu.exe

Microsoft VC 2022 14.31.31103 VC2022

3.2  Installation

Windows must be correctly installed and all system requirements must be assured before installing imc FAMOS .

To install imc FAMOS , start the program "Setup_ImcFamos_X64.exe" from the root directory of the installation
CD.

Alternatively you can select the "Software" icon and subsequently the command "Install".
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Administrator rights required

For the purposes of installation and uninstallation, a user account with administrator privileges for the PC is
required.

If you are logged on to the PC without administrator rights, log yourself out and log back on with an
administration-level user account. If you don't possess the appropriate account type, you will need the support
of your system administrator or IT department.

Select the edition of imc FAMOS to install:

The licensing procedure must precede the installation. Select the edition you have acquired. 

Start the licensing procedure by selecting the link "Activation with License Key via Internet..."

The Reader-version does not require licensing. To test the Enterprise version for 30 days, license it using the link
"Activation of  Demo Versions via Internet..."

For details on licensing, see here.

Follow the Assistant's instructions and select your preferred language for the online help files and example files
like projects, sequences and dialogs.

In the subsequent dialog, the license agreement appears. Once you have accepted its provisions, select the
installation folder to which to copy all the files.

The installation folder must be on the PC's local hard drive. imc FAMOS cannot be installed on a network drive.
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This base directory will be structured with various subdirectories where, for example, sample files are deposited.
The subdirectory \BIN, for instance, contains all executable files and program libraries; the subdirectory "\SEQ"
sample sequences (macros); the subdirectory "\DAT" has measurement data files containing information in
various data formats.

At installation, you must also supply a name for the program group; the installation program will then
supplement the Windows Start menu with a corresponding entry. If, for instance, you specify "imc" as your
group name, you will be able to call the program from the submenu "Start/ Programs/ imc".
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3.3  Start

Start imc FAMOS either via the corresponding entry in the Windows Start menu, or by clicking on the shortcut on
the Windows-Desktop which was created during the installation, or directly by calling the file "famos.exe" from
the Windows Explorer.

Licensing

The software license is administered by a License Manager. A detailed description is located in the users manual.
Earlier versions had been copyright-protected by a hardlock (blue dongle). As of imc FAMOS 6.1 this will no
longer be required. If you wish to exchange an old imc FAMOS hardlock for the License Manager, please contact
our tech support .

New data format

With imc FAMOS 7.4, the new file format imc3 is supported. This format has been designed in particular to allow
the more rapid generation of data display when the data volumes become very large. Upon successful
installation, you are presented one single time with a special decision aid dialog, which asks whether you wish to
use the new format:

 By means of FAMOS' Options dialog, it is possible to change the setting at any time. User Interface.

This document refers to the user's manual for detailed information. You can now begin by working through the
chapter Tutorial . The subsequent chapters provide an overview of the User Interface.

5

15
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4  Tutorial

4.1  Introduction
This chapter has been provided to acquaint you with some of the main features in imc FAMOS . After working
through this chapter, you should be familiar with the basic functions. When performing more complex tasks,
please refer to the relevant chapters for more detailed information.

The tutorial will demonstrate how to load a data set from a file and how to perform analysis using formulas. You
will also display channels in graphs and create an automatic sequence. Efficient use of the File Browser for quick
loading of files and for comparing data files is demonstrated.

Many of the commands used below can be called in several ways - via the imc FAMOS main menu, or via the
respective context menu (right-click of the mouse), via the corresponding icon in the toolbar or by a combination
of certain keys. In order to familiarize you with all of these options, they are each used in turn in the discussion
below, or at least mentioned as alternatives.

If you encounter unfamiliar terms in the discussion below, refer to the chapters 'User-Interface', 'Appendix' and
the help for MS-Windows.

 Note

In order to be able to follow the tutorial on the PC, at least the imc FAMOS Standard Edition is required.
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4.2  Starting FAMOS
After successfully installing, start imc FAMOS either by accessing the shortcut installed in the Windows Start
Menu or desktop.

The Start screen appears:

imc FAMOS start screen

The start screen is the entry portal to imc FAMOS. Assistants and templates can be opened from here. A detailed
description can be found in the chapter The start screen.



© 2024 imc Test & Measurement GmbH imc FAMOS 2024 - Getting Started, Doc. Rev.: 1 - 2024-02-20
Page   17

Starting FAMOS Chapter   4

By clicking on File, FAMOS switches to the classic view:

FAMOS: Main window in standard set-up

If the main window appears differently from the illustration here, select menu "View" / "Return to Default" in
order to restore the default configuration.

The workspace below the menu bar and tool bar is divided into 5 boxes:

· Variable list, displaying all channels and variables currently being processed.

· Function list, displaying all available functions and commands.

· Plug-in window, in which the separate user interfaces of extension modules are displayed. The File
Browser plug-in is permanently available for fast access to measurement files. By default, this window is
minimized, meaning that only its title bar is visible.

· Editor window, for entering and executing individual operations and sequences (macros)

· Output window, displaying help texts, error messages and warnings

The basic arrangement of these boxes is fixed (e.g., the variables list is always at the upper left), but the size and
visibility of the boxes can be altered. For instance, it's possible to grab the border between 2 boxes with the
mouse and move it, or use the corresponding buttons to minimize or maximize a box
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4.3  Directories
Select the item "Options" in the "Extra" menu. The dialog which then appears presents all the presettings
influencing imc FAMOS ' behavior. These are organized in various sections which can be selected from the list at
left. Select from here the entry "Folders". A dialog box appears, in which you can set the default folders.

Dialog "Determine default directories"

The selected directory may be changed either in the input box or by calling a dialog with "Browse", which
searches existing directories or can create a new directory.

If you have completed installation of imc FAMOS and have selected the folder "C:
\Users\Public\Documents\imc\imc FAMOS" for sample files, the subfolders should appear as follows:
"Load data files from:"  C:\Users\Public\Documents\imc\imc FAMOS\DAT

"Save data files:"       C:\Users\Public\Documents\imc\imc FAMOS\DAT

"Sequences:"             C:\Users\Public\Documents\imc\imc FAMOS\SEQ

"Curve configurations:"  C:\Users\Public\Documents\imc\imc FAMOS\CCV

"Reports:"               C:\Users\Public\Documents\imc\imc FAMOS\DRB

"Definition files:"  C:\ProgramData\imc\Common\def  (depends on system, read only)

"Projects:"              C:\Users\Public\Documents\imc\imc FAMOS\Projects

If unwanted directories are entered, simply change the appropriate entries. Confirm changes with <OK>,
otherwise <Cancel>.
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4.4  Loading Files

In the multi-function bar "Variable", select the menu item "Load". A dialog appears for
loading a file. Set the file format "imc FAMOS " below left in the format list. All data set
examples are listed in the directory box. Double-click on "slope.dat" or select the entry
and then press <OK> to load the file.

Dialog "Load FAMOS f ile"

The dialog box is closed and the file opened. The variable slope appears in the list.
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4.5  Showing Variables

Select the entry slope in the variable list by clicking on it once.

 Press function key F4 or select item "Show together" in menu "Variable". A curve window displaying the
channel appears, with the variable's name as the title.

Curve window with variable "slope"

Move and enlarge the curve window somewhat and shift it away from the lower right corner of the screen.

4.6  Zoom
Select "Zoom" in the menu "Edit". The mouse cursor takes the shape of a vertical arrow.

Stretch a selection rectangle around the desired region while holding down the left mouse button. The region is
displayed with its colors inverted.

Curve window with zoomed section
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Select a range and release the mouse. The selected range is enlarged.

Curve window with zoomed waveform

To enlarge the curve section even more, simply repeat the process. Use the "Back" function if you wish to
reverse the effects of the last actions.

Reference

'Curve Window' documentation, section 'Zoom'

4.7  Unzooming
Select item "Unzoom" in the curve window menu "Edit". The whole waveform can be seen again.
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4.8  Measure
To open the "Measure" window, select "Measure". 

Two measurement cursors (crosshairs) appear in the curve window. The curves' values at the position of the
measurement cursors are displayed in the measurement value window.

The x-value of the left crosshair is indicated by "xl = ..." and likewise with the right crosshair ("xr = ..."). The
difference between the two x-values is indicated by "dx = ..." (dx = xr - xl). In the same way, "yl" and "yr" display
the y-values of the two crosshairs. To move a crosshair, simply press the right or left mouse button and drag the
it to the desired position. The crosshair follows the path of the waveform.

Curve window with measurement cursors (crosshairs)

The horizontal line tracks the curve's y-value.

As soon as you release the mouse button, the measurement results are displayed in the "Measure" window. By
pressing moving the mouse while holding down both mouse buttons simultaneously, you can obtain
measurements applicable to a constant dx. To quit the "Measure" mode, simply close the "Measure" window.

Reference

Curve Window' documentation, section 'Measure'
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4.9  Properties

If the entry "SLOPE" in the Variables list is not displayed in inverted colors, select it by clicking on it. 

In the menu "Variable" select the item "Properties" (alternatively, push the function key F5 or click on the
corresponding symbol in the toolbar). 

A dialog box of information on the data set "SLOPE" appears, containing its length (number of data points),
sampling interval, units and comments.

Dialog: Properties

Properties which cannot be edited
are displayed in the background
color (usually gray). To exit this
dialog, select <Cancel>.
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4.10  Interpolation

If you have zoomed extensively in the curve window, you must have noticed that the plot of the data set
"SLOPE" is jagged. The channel consists of a finite amount of points. The graphical display in the curve window
simply connects the data set's points by straight lines. If you wish to smooth the curve, you can generate a new
data set on the basis of "SLOPE" by means of interpolation. To do this, enter the following formula in a new line
in the Editor box:

This creates a variable Interpol. This new
variable has a point density ten times greater
than the data set slope. 

"IPOL" is the name of the imc FAMOS function which performs such interpolation. This function has two
parameters, the data set to be interpolated (here: "Slope") as well as the interpolations factor 
(here: 10). The result of this calculation is then assigned to the newly created variable "INTERPOL".

Enter the formula by proceeding as follows: first, type
"INTERPOL =" 

Input box with formulas

Next, in the Functions box at left, select the
branch Edit\Interpolation.

Alternatively, select Search folder and enter the
word Interpolation.

Select the function Ipol.

Double-clicking on the entry IPOL copies the function name along with its corresponding parameter mask to the
current position in the editor window.
INTERPOL = IPol(,)

Next, double-click in the Variables list on the entry "SLOPE" (to the right of the symbol). The variable's name is
copied to the Editor box:
INTERPOL = IPol(SLOPE,)

Click once with the mouse between the comma and the right parenthesis and type in 10. The formula is now
complete.

Now, we can test the formula. The line just entered must be denoted as the active formula. To do this, double-
click on this line, which then is shaded light gray, and to the left of the line a little arrow button then appears.

Execute command line with button

Thus, the currently active line is denoted in an
unmistakable way, and by clicking on the button,
the formula in this row is carried out.

Click on the button circled to execute the formula. If the formula was entered incorrectly, an error message
appears. Correct the formula before attempting to execute it again.
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Alternatively, you can use the combination of keys "CTRL" + "ENTER" to activate and execute the line with the
input cursor.

Once the formula has been successfully calculated, the entry Interpol appears already selected in the variables
list. Use function key F4 or the appropriate button in the tool list to view data set Interpol.

Curve window with variable 'INTERPOL'

Close the curve window and activate the window slope. Select "Unzoom" to view the entire curve.

Remarks

· Function and variable names can also be entered in the editor window using drag&drop. Refer to chapter
'User Interface', sections 'Variables List' and 'Function List'.

· As an alternative to the methods of manually entering formulas named, the parameterizing Assistant can
be used. To access this, select the function "IPOL" in the functions list and use the combination of keys
"SHIFT" + "F1", or select the corresponding menu item in the function list's context menu.

· If you select a function in the functions list or click on a function name in the input box, then a short
description ("Quickhelp text) of the function appears in the output box. 

Reference

Chapter 'Functions', Section 'Function Assistant'.
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4.11  Two channels in Curve Window
For better comparison of two curves, display both in the same curve window.

To do this, right-click in the curve window. In the context menu which then appears, select the item "More
Channels...". In the following dialog, you can select additional variables and configure their appearance in the
same curve window.

FAMOS: Dialog "More channels in curve window"

All data sets available for selection are listed in the list at right. The channels already displayed are indicated in
the list at left.
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Click on the data set interpol in the right list and drag the mouse while keeping its button pressed to the left
list below the variable slope. Next, enter interpol in the left box as the second curve. Click the leftmost of
the three screen buttons and click onto the interpol entry, in order to cause this waveform to be displayed in
the curve window, sharing the x-axis of slope, but featuring its own y-axis.

Curve window with two curves

Click on the screen button <OK>. The dialog is closed and the curve window redrawn, with two y-axes for two
curves.

Note

The same result could be achieved by employing drag&drop on the data set's entry in the variables list;
depositing the entry in the middle of the curve window.
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Curve window with two curves (separate axes)

In order to compare two curves, it is useful to set the same value range for both curves. Double-click between

labels of the right (2nd) y-axis or select the menu item "Axes"in the curve window menu "Y".

A dialog box for scaling the axis appears.

FAMOS: Dialog for scaling y-axes

Select "Range selection/ Like previous axis" (base axis is the left y-axis).

We also wish to change the line style with which the curve "INTERPOL" is drawn. To do this, push the button
"Topic" and from the menu which appears, select the item "Lines...".
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Select from the axes list at left the data set "INTERPOL". Then select under "Line type" the item "Dots".

Select <OK> to close the dialog box. The curve window is redrawn. The right y-axis is deleted; the left y-axis
applies to both curves, and is scaled according to the setup in the dialog box for selecting the range. The second
curve (data set INTERPOL) is represented by a dotted line.

Curve window with two curves (common axis)

Note

The same result can also be achieved using the previously discussed dialog "More channels in curve window",
by selecting the y-axis in the axes list and clicking on the Delete icon.

Zoom into close range to see the dots clearly.

To make the two separate waveforms yet more distinct, display the data set slope (1st curve) in a stair-step
display.

To do this, select the menu item "Configuration/Lines". From the axes list which appears at the left of the dialog,
select the item "SLOPE".

Select "Steps" in the menu "Line type" selection list and then select <OK>. Zoom in the new curve display. Here,
the function "IPol" was used to interpolate the data set slope through cubic splines.

Curve window with two curves in dif ferent display types
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4.12  Changing a Formula

Change the formula to get a lower interpolation factor.
INTERPOL = IPol(SLOPE, 3)

There are two ways to do this:

Changing the formula in the Editor

Use either of the keys BACKSPACE or DELETE to delete characters and change the parameter.

To apply the change, press the key combination Ctrl + ENTER. Alternatively, activate the line by double-
clicking and then click on the "Execute"-button. The curves displayed are updated.

Calling the Formula Assistant from the Editor

Click on the function so that the cursor is on the blue letter. Press SHIFT + F1.

Open Formula Assistant with SHIFT + F1

The Formula Assistant for the IPol()
function appears with the parameters
entered. The function is selected in the
Editor. Change the parameter in the
Assistant and click on "Execute". In the
curve window, you can observe the
change directly. if you are satisfied with
the result, you can overwrite the line by
clicking on "Copy" in the Editor.

Curve window with two curves in dif ferent display types
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4.13  Single Values
Calculate the maximum of the data set slope. Enter the following formula in the Editor box on a new line:
Maxim = Max(SLOPE)

The function "Max" is found e.g. in the branch Analysis\Statistics of the Functions tree diagram.

After the formula has been executed by pressing "CTRL + RETURN", a further entry appears in the variable list:

The dice symbol shows that the value is a single value, occupying no extent
of time, in contrast to the data sets slope and interpol. If the value of
the variable "Maxim" is not displayed, activate the option "Single value:
show content" in the dialog "Extra/ Options/ Variables list...".

The value can also be displayed in a single value window by pressing F4.

Single value window

4.14  Calculations

A new data set is to be generated by reducing the data set slope by its mean value:
FREE = SLOPE - Mean(SLOPE)

The function "Mean" (e.g. in the branch Analysis\Statistics\Standard of the Functions tree diagram) calculates
the arithmetic mean of the specified channel. This mean value is subtracted from the data set slope.

Execute this formula and display the data set "FREE" by clicking on the curve symbol in the tool bar.

Curve window with one variable

You will notice that the waveform "FREE" has the same shape as the data set slope, but all its values have been
decreased by the mean value of slope.
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4.15  Data Editor

Select "FREE" in the variable list, which you have previously generated in the chapter
Calculations . Then select the icon "Data Editor" in the Variables toolbar.

A new window appears. A table listing the individual numerical values of the data set "FREE" is found in the left
column.

Data Editor

Use the scroll bar on the right side to view further numerical values. Close the window.

Reference

Chapter 'Data Editor'.

31
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4.16  Saving results

Select "FREE" in the variable list and "Save Individually..." in the menu "Variable". A dialog box appears for
entering a file name under which the variable should be stored. Set the file format to "imc FAMOS ". The file
"FREE.DAT" is created by selecting <Save>. This data set may be reloaded later.

Dialog "Save File"

Reference

Chapter  'File Management'.

4.17  Deleting variables
The variables "FREE", "Maxim" and interpol are no longer needed and should be deleted from the Variables
list. First select these variables in the Variables list, then select "Delete" in the menu "Variable". The only entry
remaining is the variable slope.
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4.18  Spectrum

Load file "SIN3.DAT". Display the waveform by pressing function key F4.

Curve window displaying variable "sin3"

The data set contains several periods of a sine-shaped signal, which has a strong third harmonic (second
harmonic oscillation). The distortion of the signal around its zero passages is typical for such a curve.

Enter the following formula to calculate the spectrum of the variable "SIN3":
SPECTRUM = Spec(SIN3)

The function "Spec" is found e.g. int he branch Analysis\Spectral Analysis\General. Double-click on this line in the
functions list, as well as on the variable "SIN3" in the variable list. Complete the formula using the keyboard.

Execute the formula. "SPECTRUM (MP)" appears in the variables list. A complex variable was generated in
Magnitude / Phase (MP) representation.

Press function key F4 to display the spectrum magnitude in the curve window.

Curve window displaying magnitude of  spectrum

The magnitude of the spectrum exhibits a strong fundamental wave and a somewhat smaller second harmonic
oscillation.

Note that the fundamental wave has a somewhat smaller amplitude than the signal "SIN3". The amplitudes of
the oscillations correspond to those which would be exhibited by a selective voltmeter.
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Note

The Spec function is based on Fast-Fourier-Transformation, which is the function FFT() in the same group.
These calculations normally require additional parameters such as windows and window widths. As a quick
way to enter the parameters, they are entered globally under Options.There, you will set up the data window
and decide whether to interpolate the data set to obtain a number of points which is the nearest power of 2,
or to fill the data set with zeroes. In the example, the window was set to "Square" and "Fill with zeroes" was
deactivated.

4.19  Complex data sets

If "Spectrum.M" and "Spectrum.P" are not indicated in the Variables list, move the mouse pointer into the
variable box and right-click the mouse. Click on "Show Components" in the context menu.

This menu item is checkmarked if and when it is active. Additional entries now appear in the Variables list:
"SPECTRUM.M" and "SPECTRUM.P". These are the magnitude and phase components, respectively, of the
complex data set.
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Select the entry "SPECTRUM.P" in the Variables list by clicking once. Press function key F4 to display the phase of
the spectrum in a curve window.

Curve window with phase of  spectrum, unscaled

The phase spectrum should be displayed from -180° to +180°.

Double-click in the space between the y-axis labeling in the curve window SPECTRUM.P. A dialog appears for
scaling the y-axis.

Under "Range selection", select "Fixed Range: min, max" from the menu "Range", and enter in the
corresponding text boxes Minimum = -180 degrees, Maximum = 180 degrees and Tick selection = "Ticks at f ixed
distances" "Tick distance" = 90.

Dialog for scaling the y-axis

Click on <OK> to close the dialog.
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Curve window with phase of  spectrum, scaled

imc FAMOS now attempts to display the specified range from -180° to +180° with appropriate axis labels.

4.20  Creating sequences

A sequence (also called a macro) is a series of operations which imc FAMOS executes automatically in the
specified order. Frequently used series of operations can be automated by creating sequences.

Suppose, for example, the "f requency" of signal "SIN3" is to be found. Here we will define the "f requency" as the
maximum oscillation occurring in the spectrum of the signal.

First open a new, empty sequence. Right-click the mouse over the Editor box's title bar and select the item
"New" in the context menu which then appears. Alternatively, you can use the combination of keys "CTRL"+"N"
or the corresponding icon at the upper left of the Editor box's toolbar.

A new tab then appears in the Editor box's title bar, "Unnamed0". This is then active and the sequence it pertains
to (which is empty at the moment) is displayed. Any other sequences, whether newly created or already opened,
would be displayed in the same way; to move between sequences, simply click on the tab in the title bar which is
associated with the sequence desired.

First, activate the standard Editor box (the tab all the way to the left) and select the previously entered formula
SPECTRUM = Spec(SIN3)

using the mouse. Via the context menu or by means of "CTRL"+"C", copy the formula text to the Windows
Clipboard. Switch back to the new sequence and enter the formula text into the sequence as the first line by way
of the context menu or "CTRL"+"V".

Sequence Editor (with command)
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Now enter the following formula in the next line:
Freq = Pos( spectrum.m, Max (spectrum.m))

The x-position of the spectrum's maximum magnitude is determined. Execute this formula once as a test by
double-clicking in the command line and then clicking on the arrow key (appearing at the left of the
command currently in readiness), or alternatively, CTRL + ENTER. Correct any errors if an error message
appears.

Now enter the line
SHOW freq

in the text window. This command displays the variable "FREQ" in the curve window.

You have created a sequence consisting of three commands.

Sequence Editor

4.21  Executing sequences

First delete the variables created in the sequence.

Select entries "SPECTRUM...MP" and (if present) "FREQ" and then select "Delete" in the menu "Variable".

Now select from the context menu (accessed by right-clicking the mouse over the Editor box's title bar) the
menu item "Execute". Here, too, you have the alternative to use the keyboard ("F7") or the corresponding icon
in the editor box's toolbar.

The sequence is now carried out, starting from the first line.

At the end of the sequence, a single value window is displayed indicating the calculated frequency.

Single value
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4.22  Changing sequences
The procedure introduced for determining the frequency works only for signals with a relatively small offset.
Therefore, the signal's mean value shall be removed.

Change the first line in the Sequence Editor as follows:
SPECTRUM = Spec( SIN3 - Mean(SIN3))

The calculated data set "SPECTRUM" should automatically be deleted because it is used as an intermediate
result in the sequence. Enter the following line at the end of the Editor box:

Delete spectrum

Restart the sequence.

Sequence-editor

4.23  Saving sequences

Select the menu item "File" / "Save" or right-click the mouse on "Input" and then "Save As...". Save the sequence
under the name "Frequency.SEQ". 

Alternatively, you can save the sequence by clicking on the
diskette icon in the Editor.

Close the sequence you just made by clicking on "X", or select the
context menu item "Close".

You can now run the saved sequence directly. To do this, enter the command:
SEQUENCE Frequency.SEQ 

The file "Frequency.SEQ" is opened in the background and the sequence it contains is executed.

4.24  Creating documention with Panels

After analysis of the measured data, documenting the results is usually the next step. This means not only saving
the file, but also the creation of various documents (either digital or hard copy) for the saving and presentation
of the results.

Create a report page for documentation of results.
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Procedure

Load the data set slope and use the following command lines to obtains its statistics values:
FAMOS
LOAD slope
Maximum = Max(slope)    ; Group: Analysis > Statistics > Generic
Minimum = Min(slope)    
MeanValue = Mean(slope) 

· Create a Report page as a Panel. Go to the menu item File-> New-> New Panel-> Report (Portrait).

· In the tool window at the bottom left, select Standard>Label and then in the Report page drag open a
frame for it (holding down the left mouse button).

· Next, leave the tool window and go to the Properties window. In the text box under the item Text,
enter a title for your report. Under Font, you can alter the font and font size.

· Go to the page Edit under General and use "Insert Widget" > Standard > Image to add a placeholder
for an image to the report. In the Properties window under Image, select a picture or logo on your
hard drive and have it displayed.

· In the Standard variables list, highlight the channel "slope", drag it to an empty area in your report and
release the left mouse button there. Select Standard for a standard curve window.

· Select the results Maximum, Minimum and MeanValue in the Variables list and drag them together to
below the curve window of the channel "slope". After releasing the left mouse button, select the
option "Numerical".

· To see the complete page, right-click at the bottom right in the Zoom box on the rectangle.

Save this page as part of the Panel using File -> Save and assign it the filename FirstPanel.panel.

Export the report as a PDF using File -> Export as PDF under the name PDFReport.pdf.

Result

You have created as report which was also exported as a DIN-A4 page PDF.

Within a Panel, you can also create multi-page reports and of course export all of them in PDF.
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4.25  Favorites
Formulas or sequences used frequently can be entered into a list of favorites, in order to save on time spent
typing.

Open the context menu by right-clicking the mouse over the list and select the menu item "New Entry". In the
dialog which then appears, enter a short, descriptive name under "Caption", e.g. "1/3-octave analysis". The
actual text is entered in the Statement box. You can, for example, enter the formula manually, or use "Copy" and
"Paste" to get it from the editor box, or even easier, use the formula input box's context menu to transfer in the
currently active line in the editor box. Now you can also enter a short description and a help text.

Dialog for def inition of  "Favorites"

The option "Execute!" ensures that the entry will be executed upon double-clicking on it.

The new entry is now shown in the Favorites list; double-clicking on it is enough to have the sequence
"Third_Octave.SEQ" carried out.

Reference

Chapter 'User Interface', Section 'Administering Favorites' 

You have now successfully completed the Tutorial.
We wish you much success in working with imc FAMOS .
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Address

imc Test & Measurement GmbH
Voltastr. 5
13355 Berlin

Phone: (Germany): +49 30 467090-0

E-Mail: info@imc-tm.de

Internet: https://www.imc-tm.com

Tech support

If you have problems or questions, please contact our tech support:

Phone: (Germany): +49 30 467090-26

E-Mail: hotline@imc-tm.de

Internet: https://www.imc-tm.com/service-training/

imc ACADEMY - Training center

The safe handling of measurement devices requires a good knowledge of the system. At our training center,
experienced specialists are here to share their knowledge.

E-Mail: schulung@imc-tm.de

Internet: https://www.imc-tm.com/service-training/imc-academy

International partners

You will find the contact person responsible for you in our overview list of imc partners:

Internet: https://www.imc-tm.com/imc-worldwide/

imc @ Social Media

https://www.facebook.com/imcTestMeasurement

https://www.youtube.com/c/imcTestMeasurementGmbH

https://twitter.com/imc_de

https://www.linkedin.com/company/imc-test-&-measurement-gmbh

Contact imc

mailto:info@imc-tm.de
https://www.imc-tm.com
mailto:hotline@imc-tm.de
https://www.imc-tm.com/service-training/
mailto:schulung@imc-tm.de
https://www.imc-tm.com/service-training/imc-academy
https://www.imc-tm.com/imc-worldwide/
https://www.facebook.com/imcTestMeasurement
https://www.youtube.com/c/imcTestMeasurementGmbH
https://twitter.com/imc_de
https://www.linkedin.com/company/imc-test-&-measurement-gmbh
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